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CERTIFICATION 

VTI Microwave, a business unit of VTI Instruments Corp. (VTI) certifies that this product met its published 
specifications at the time of shipment from the factory. VTI Microwave further certifies that its calibration 
measurements are traceable to the United States National Institute of Standards and Technology (formerly National 
Bureau of Standards), to the extent allowed by that organization’s calibration facility, and to the calibration facilities 
of other International Standards Organization members. 

WARRANTY 

The product referred to herein is warranted against defects in material and workmanship for a period of one year 
from the receipt date of the product at customer’s facility. The sole and exclusive remedy for breach of any warranty 
concerning these goods shall be repair or replacement of defective parts, or a refund of the purchase price, to be 
determined at the option of VTI Microwave. 

For warranty service or repair, this product must be returned to a VTI Instruments authorized service center. The 
product shall be shipped prepaid to VTI and VTI shall prepay all returns of the product to the buyer. However, the 
buyer shall pay all shipping charges, duties, and taxes for products returned to VTI from another country. 

VTI Microwave warrants that its software and firmware designated by VTI Microwave for use with a product will 
execute its programming when properly installed on that product. VTI Microwave does not however warrant that the 
operation of the product, or software, or firmware will be uninterrupted or error free. 

LIMITATION OF WARRANTY 

The warranty shall not apply to defects resulting from improper or inadequate maintenance by the buyer, buyer-
supplied products or interfacing, unauthorized modification or misuse, operation outside the environmental 
specifications for the product, or improper site preparation or maintenance. 

VTI Microwave and VTI Instruments Corp. shall not be liable for injury to property other than the goods 
themselves. Other than the limited warranty stated above, VTI Instruments Corp. makes no other warranties, express 
or implied, with respect to the quality of product beyond the description of the goods on the face of the contract. 
VTI Microwave specifically disclaims the implied warranties of merchantability and fitness for a particular purpose. 

RESTRICTED RIGHTS LEGEND 

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in subdivision (b)(3)(ii) of the 
Rights in Technical Data and Computer Software clause in DFARS 252.227-7013. 

VTI Microwave 
A VTI Instruments Corp. Business Unit 
2031 Main Street 
Irvine, CA 92614-6509  U.S.A. 
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D E C L A R A T I O N  O F  C O N F O R M I T Y  
Declaration of Conformity According to ISO/IEC Guide 22 and EN 45014 

 
MANUFACTURER’S NAME VTI Instruments Corp. 
 
MANUFACTURER’S ADDRESS 2031 Main Street 
 Irvine, California 92614-6509 
 
PRODUCT NAME Microwave Switch Assembly with LAN Interface 
 
MODEL NUMBER(S) EX7000 Series Microwave Switch Assemblies 
 
PRODUCT OPTIONS All 
 
PRODUCT CONFIGURATIONS All 
 
 

VTI Instruments Corp. declares that the aforementioned product conforms to the requirements of 
the Low Voltage Directive 73/23/EEC and the EMC Directive 89/366/EEC (inclusive 93/68/EEC) 
and carries the “CE” mark accordingly. The product has been designed and manufactured 
according to the following specifications: 

 
 
SAFETY EN61010 (2001) 
 
EMC EN61326 (1997 w/A1:98) Class A 
 CISPR 22 (1997) Class A 
 VCCI (April 2000) Class A 
 ICES-003 Class A (ANSI C63.4 1992) 
 AS/NZS 3548 (w/A1 & A2:97) Class A 
 FCC Part 15 Subpart B Class A 
 EN 61010-1:2001 
 
 
 
 
 
 
 
 
 
 
 
 
I hereby declare that the aforementioned product has been designed to be in compliance with the relevant sections 
of the specifications listed above as well as complying with all essential requirements of the Low Voltage Directive. 
 
August 2008 
 

 

 

 
  Steve Mauga, QA Manager 
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GENERAL SAFETY INSTRUCTIONS 

Review the following safety precautions to avoid bodily injury and/or damage to the product. 
These precautions must be observed during all phases of operation or service of this product. 
Failure to comply with these precautions, or with specific warnings elsewhere in this manual, 
violates safety standards of design, manufacture, and intended use of the product. 
 
Service should only be performed by qualified personnel. 
 
 

TERMS AND SYMBOLS 

These terms may appear in this manual: 
  
WARNING Indicates that a procedure or condition may cause bodily injury or death. 
  
CAUTION Indicates that a procedure or condition could possibly cause damage to 

equipment or loss of data. 
  
These symbols may appear on the product: 
  

 

ATTENTION - Important safety instructions 

  

 

Frame or chassis ground 

  

 

Indicates that the product was manufactured after August 13, 2005. This mark is 
placed in accordance with EN 50419, Marking of electrical and electronic 
equipment in accordance with Article 11(2) of Directive 2002/96/EC (WEEE). 
End-of-life product can be returned to VTI by obtaining an RMA number. Fees 
for take-back and recycling will apply if not prohibited by national law. 

 
WARNINGS 

 
Follow these precautions to avoid injury or damage to the product: 
  
Use Proper Power Source To avoid electrical overload, electric shock, or fire hazard, do not 

use a power source that applies other than the specified voltage. 
Operating Conditions To avoid injury, electric shock or fire hazard: 
 - Do not operate in wet or damp conditions. 
 - Do not operate in an explosive atmosphere. 
 - Operate or store only in specified temperature range. 
 - Provide proper clearance for product ventilation to prevent 

overheating. 
 - DO NOT operate if any damage to this product is suspected. 

Product should be inspected or serviced only by qualified 
personnel. 

Improper Use The operator of this instrument is advised that if the equipment is 
used in a manner not specified in this manual, the protection 
provided by the equipment may be impaired. 
Conformity is checked by inspection. 
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SUPPORT RESOURCES 

Support resources for this product are available on the Internet and at VTI Instruments customer 
support centers. 

 
VTI Microwave 
A VTI Instruments Business Unit 
World Headquarters 
 
VTI Instruments Corp. 
2031 Main Street 
Irvine, CA 92614-6509 
 
Phone: (949) 955-1894 
Fax: (949) 955-3041 
 
VTI Instruments 
Cleveland Instrument Division 
 
5425 Warner Road 
Suite 13 
Valley View, OH 44125 
 
Phone: (216) 447-8950 
Fax: (216) 447-8951 
 
VTI Instruments 
Lake Stevens Instrument Division 
 
3216 Wetmore Avenue, Suite 1 
Everett, WA 98201 
 
Phone: (949) 955-1894 
Fax: (949) 955-3041 
 
Bangalore Instrument Division 
 
135, II & III Floors 
Infantry Road 
Bangalore – 560 001 
India 
 
Phone: +91 80 4040 7900 
Fax: +91 80 4170 0200 
 
Technical Support 
 
Phone: (949) 955-1894 
Fax: (949) 955-3041 
E-mail: support@vtiinstruments.com 
 

Visit http://www.vtiinstruments.com for worldwide support sites and service plan information. 
 

  

mailto:support@vxitech.com
http://www.vxitech.com/
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 SECTION 1 

INTRODUCTION 
INTRODUCTION 

The EX7000 series of modular microwave switch assemblies consist of standard products as well 
as custom factory configured enclosures. All are rack mountable and range in size from 1U to 4U. 
The standard products include the EX71HD, a 1U high-density, 26 GHz non-latching microwave 
switch mainframe; the EX72SF, a 2U high-density, 26 GHz latching microwave switch 
mainframe; the EX72CC, a 2U high-density switch mainframe optimized for 12V non-latching 
relays such as the Teledyne CR/CT series; and the EX7400, a 4U switching platform that is 
custom built per customer specifications, but contains the same LAN interface, relay driver 
boards, and power supply (unless otherwise required or specified) as the EX71HD and EX72SF. 
The EX7400 can contain an assortment of electromechanical relays, plus any additional active or 
passive components that may be required. Every member of the EX7000 series comes with an LXI 
compliant LAN interface. 

EX71HD: High-Density 26 GHz Modular Microwave Switching, Non-Latching 

1588 

POWER 
LAN EX71HD 

SW 1 SW 3 SW 2 SW 4 SW 5 SW  6 SW 7 SW 8 SW 9 SW 10 SW 11 SW 12 

VTIMicrowave

 

FIGURE 1-1: EX71HD (SHOWN WITH A FULL COMPLIMENT OF HIGH-DENSITY SWITCHES) 

The EX71HD measures only 1U (1.75”) in height yet can be configured with up to twelve 
miniature microwave switches. Any combination of the following switches may be installed: 

7100 Six line pass-through adapter 
7102 Dual SPDT 
7104 SP4T 
7106 SP6T 
7122 Transfer 

The unit can be delivered preconfigured with any combination of switches. Any slot that remains 
empty may be populated later as required. The EX71HD is a totally self-contained unit with an 
EX7000 and ac power supply built in to the assembly. 
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EX72SF: High-Density 26 GHz Modular Microwave Switching, Latch with Self-Terminating Options 

EX72SF 

1588 

POWER 

LAN 

SW 1 SW 2 SW 3 SW 4 SW 5 SW 6 

 1 2 C 

SW7 SW8 SW9 SW10 SW11 SW12 

VTI
Microwave
A  V XI Tech nol ogy B usin ess U ni t

TM

 1 2 C  1 2 C  1 2 C  1 2 C  1 2 C 

 

FIGURE 1-2: EX72SF (SHOWN WITH A FULL COMPLIMENT OF AGILENT SWITCHES) 

The EX72SF is a 2U (3.5”) enclosure that can house up to six Agilent SPDT switches as well as 
up to six full-size Agilent multi-pole, single throw, terminated or unterminated, latching switches 
(see Table 3-2 for available switch modules). As with the EX71HD, it can be delivered 
preconfigured with any combination of switches with the capability of populating empty slots on-
site as required. The EX72SF is a self-contained unit that uses the EX7000 and an AC power 
supply built into the assembly. Also provided on the EX72SF is a 32-channel, general purpose I/O 
bus. Access to this bus is through a front panel-mounted 37-pin D-sub connector. Further details 
on this bus can be found in Section 3. 

EX72CC: LXI Based Custom RF Interface Platform 

The EX72CC is a 2U(3.5”) enclosure that can house up to six SPDT switches as well as up to six 
full size(2.25” square) multi-pole, terminated or unterminated 12V switches. Contact the VTI sales 
team for the full list of possible switch choices. As with the EX71HD and the EX72SF, it can be 
delivered preconfigured. The EX72CC is a self-contained unit that uses the EX7000 and an AC 
power supply built into the assembly. Also provided on the EX72CC is a 32-channel, general 
purpose I/O bus.  

EX7400: LXI Based Custom RF Interface Platform 

The EX7400 is built around the same internal components as the EX71HD and EX72SF. It starts 
life as a 4U high and 24” deep rack mountable enclosure. It can be purchased in this configuration 
allowing a customer to add their own RF and microwave components to the front and rear panels 
as well as the removable mezzanine that is located at approximately the mid way point between 
the top and bottom covers. It may also be supplied as a custom or special unit which is 
preconfigured at the factory with all of the components and inter-connect cabling specified by the 
customer. 

COMMON FEATURES 

Preconfigured units, whether an EX71HD, EX72SF, EX72CC, or the EX7400, are delivered with 
a complete device configuration file (DCF) that contains all the pertinent details about each 
programmable device mounted inside. In the case of the EX7400, which may contain internal 
inter-connect path cabling, the DCF also contains all of the point-to-point signal path information. 
The information included in the DCF allows the user to establish a complete signal route by 
indicating only the end points in a compliant IVI-Switch Connect statement, thus simplifying the 
programming task. 

All EX7000s consists of an LXI Class A compliant digital controller interface, one or more 
72-channel relay driver boards, an integrated ac power supply, and a selectable assortment of 
electromechanical microwave switches. More than one relay driver board is used in custom 
applications where the internal number of coils exceed the 72 coil capacity of a single relay driver 
board. As many as four total relay driver boards can be used in large designs. Extremely large 
designs, that require five to eight relay driver boards, can be accommodated with special hardware 
and software updates. Please consult the factory for details. 
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INTERACTIVE CONTROL 

As LXI-compliant devices, EX7000s have an embedded web server running which provides a Java 
applet for interactively configuring the box for its specific configuration as well as allowing for 
the direct control of components. 

A functional list of the actual components within the enclosure is stored on-board in non-volatile 
memory. Opening of the Soft Front Panel (SFP) results in a graphical depiction of the various 
switching components along with an indication of the current state of their contacts. Simple mouse 
clicks on the web browser can easily and quickly open and close any contact. 

The DCF can be edited using a simple software tool called the EX7000 System Configurator. This 
is especially convenient when additional microwave switches are added in the field. Use of the 
System Configurator is detailed in Appendix A. 

 

FIGURE 1-3: JAVA-BASED GRAPHICAL USER INTERFACE 

RELAY DRIVE CONTROL 

The EX7000 contains a proprietary circuit board set consisting of a Relay Driver Board (RDB) 
and a Digital Controller Board (DCB), which is known as the EX7000 when supplied as a set 
without an enclosure. They have been designed to provide maximum flexibility for controlling 
virtually any type of RF/microwave relay or component. Each RDB provides 72 high-current 
drivers, which are divided into twelve sections of six lines. Each section consists of: 

• six high-current drive lines 
• six indicator/status bits 
• one reset line 
• four relay ID bits 
• one relay power input 
• one 5 V input 
• one ground 
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Each driver board is capable of recognizing and controlling either latching or non-latching switch 
modules. A programmable delay (per driver board) dictates the amount of time allocated to relay 
settling times and current cutoffs (for latching relays). Each driver board has a single 
programmable delay parameter. The programmable delay for any board should be set to the 
maximum value required by any component connected to that board. 

Data is latched to the gate of the output coil drive FET dictating whether or not the FET will sink 
current and energize the relay coil. See the EX7000 Manual (P/N: 82-0118-000) for more details. 

INTERFACING WITH OTHER COMPONENTS 

The EX7000 board set is capable of controlling other programmable components, such as filters 
and attenuators, through either the high-current channels or the 32-bit parallel I/O. Access to the 
control lines can be achieved in various ways. The high-current channels are available from the 
EX71HD, EX72SF, and EX72CC via pass-through switches that mount on the front panel in place 
of one or more switches. These switches consist of a flat mounting plate with mounting holes to 
match the multi-throw switch it replaces. A multi-pin connector is mounted to the plate and the 
connector is wired directly to one of the relay driving connectors, allowing external use by the 
user. 

In addition to the high-current control lines, the EX72SF and the EX72CC also has a rear panel 
mounted, 32-channel, TTL-level, general purpose IO bus available. Refer to Section 3 for details 
or obtain a copy of the EX7000 Manual for more information on this bus. Contact the factor or 
visit the VTI Instruments Corp. website for a copy of this document. 

FEATURES 

Relay Odometer 

Each relay drive line has an associated “odometer” which tracks the number of times a relay coil 
has been actuated. This data is written to non-volatile memory and can be queried from application 
code or the web interface. This assists preventative maintenance programs as relays can be closely 
monitored as they near end-of-life. 

Exclude Lists 

The supplied API supports the implementation of exclude lists. Undesirable combinations of relay 
closures can be stored and warnings or errors will be generated any time an excluded combination 
is attempted. This helps prevent unsafe conditions such as shorting sources to ground or coupling 
one source to another. 

Scan Lists 

Up to 16,000 scan list elements can be stored to help reduce overhead that can be accrued when 
relying on the host controller to manage the sequencing of switch states. A predefined list of 
switch states can be stored on-board and advanced through hardware control/handshaking with 
external system devices via the LXI Trigger Bus or the GP digital I/O port. Use of scan lists can 
considerably speed up test execution times. 

Configuration Table 

The information included in the DCF allows the user to establish a complete signal route by 
indicating only the end points in a compliant IVI-Switch Connect statement, thus simplifying the 
programming task. 

Programmable MBB and BBM 

The application code can globally define whether or not the relays ‘break-before-make’ or ‘make-
before-break’ when sequencing through relay setups in a scan list. 
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EX7000 SPECIFICATIONS 

GENERAL SPECIFICATIONS 
PHYSICAL DIMENSIONS  
EX71HD 17.28” (48.2 cm) width x 14.24” (61.6 cm) depth* x 1.72” (4.5 cm) height 
EX72SF 17.25” (48.2 cm) width x 14.09” (61.6 cm) depth* x 3.28” (8.9 cm) height 
EX7400 17.25” (48.2 cm) width x 14.09” (61.6 cm) depth* x 6.56” (17.8 cm) height 
 * excludes coaxial connector protrusion from face of front and/or rear panels 
CONNECTORS  
Host interface 
Trigger bus 
 
GP digital I/O 
 
AC power 

RJ-45 (CAT 5e) Ethernet (10/100T) 
Dual 25-pin mini D-sub 
8 LVDS in/out, LXI Class A 
9-pin D-sub 
8 TTL I/O 
IEC EN 60320 C13 

RESET  
 Momentary push-button LAN reset, available through rear panel access hole 
POWER  
Voltage 90 V ac to 264 V ac, 47 Hz to 63 Hz 
Power 110 VA max (EX71HD), 20 VA max (EX72SF) 
 
DIGITAL CONTROLLER BOARD (DCB) 
PROCESSOR MCF5272 
SDRAM 
Flash ROM 
Single-command response time 

32 MB 
8 MB 
< 3 ms 

 
RELAY DRIVER BOARD (RDB) 
RELAY POWER  
 +5 V to +48 V 

*Three power pins, each connected to four relay driver connections 
RELAY DRIVERS  
 72 open-drain high-current sink on a standard board. Options available to replace 

some or all of the open drain outputs with TTL drivers. Expandable to 576. 
Twelve open-drain very high-current sink drivers for reset. Arranged as one 
drive line per relay driver connector as well as 12 lines together on one connector 
on J21. 

MAXIMUM CURRENT SINK  
 200 mA (all channels ON) for 72 channels 

410 mA (individual channels) for 72 channels 
800 mA for 12 reset lines 

TTL I/O  
 32 channels per board, expandable to 256 
MODULE ID  
 Rotary switch (0 through 7 identifies driver board in chain) 

 
SOFTWARE 
PROGRAMMATIC CONTROL  
 IVI-COM and IVI-C API 

IVI similar API for Linux 
DOS-based interactive command set 

INTERACTIVE CONTROL  
 Embedded Java applet 
CONFIGURATION TABLE  
 128 elements (power-on, last known, user-defined) 
SCAN LIST  
 16k set-ups 
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LXI REQUIRED SPECIFICATIONS 
TRIGGER RESPONSE TIMES  Minimum Typical Maximum 
Trigger Source 
 LXI WTB 
 DIO port 
 LAN event 
 Alarm 

 
 948 µs 1 ms 1.4 ms 
 948 µs 1 ms 1.4 ms 
 3.8 ms 4 ms 4.2 ms 
 700 µs 1 ms 1.8 ms 

EVENT RESPONSE TIMES  Minimum Typical Maximum 
Event Source → Trigger Destination 
 LXI WTB → LXI WTB 
 LXI WTB → DIO port 
 LXI WTB → LAN event 
 DIO port → LXI WTB 
 DIO port → DIO port 
 DIO port → LAN event 
 LAN event → LXI WTB 
 LAN event → DIO port 
 LAN event → LAN event 
 Alarm → LXI WTB 
 Alarm → DIO port 
 Alarm → LAN event 
 Operation Complete → LXI WTB 
 Operation Complete → DIO port 
 Operation Complete → LAN event 

 
 37.5 ns 40 ns 50 ns 
 54 ns 60 ns 65 ns 
 1.26 ms 1.4 ms 1.5 ms 
 56 ns 60 ns 66 ns 
 26 ns 30 ns 39 ns 
 1.19 ms 2.0 ms 2.2 ms 
 3.7 ms 4 ms 4.8 ms 
 3.7 ms 4 ms 4.8 ms 
 14.8 ms 16 ms 25 ms 
 36 ns 36 ns 36 ns 
 36 ns 36 ns 36 ns 
 1.2 ms 1.35 ms 1.45 ms 
 320 µs 500 µs 600 µs 
 320 µs 500 µs 600 µs 
 1.8 ms 1.9 ms 2.0 ms 

TIMESTAMP ACCURACY  
 200 µs 
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EX71HD DIMENSIONAL DIAGRAM 

17.28 in
438.91 mm

18.28 in
464.31 mm

14.24 in
361.61 mm

15.24 in
387.01 mm

2.73 in
69.22 mm

1.72 in
43.69 mm

1588 

POWER 
LAN EX71HD 

SW 1 SW 3 SW 2 SW 4 SW 5 SW  6 SW 7 SW 8 SW 9 SW 10 SW 11 SW 12 

90-264 VAC 
50 / 60 Hz 

25VA MAX. 

TRIGGER BUS 
DIGITAL I/O 

RESET 

ETHERNET 

10/100 BASE-T 

VTIMicrowave

VTIMicrowave

 

EX72SF DIMENSIONAL DIAGRAM 

3.28 in
83.38 mm

4.47 in
113.51 mm

17.25 in
438.15 mm
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463.55 mm
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25VA M AX.  

GP I/O 
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EX72CC DIMENSIONAL DIAGRAM 
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 SECTION 2 

PREPARATION FOR USE 
OVERVIEW 

This section provides a step-by-step process for setting up the EX7000 series assemblies for use. 
For simplicity, the EX7000 series assemblies, including the EX71HD, EX72SF, EX72CC, and 
EX7400 will be referred to as EX7000 in this section. It covers hardware installation, input 
connections, and software installation. 

UNPACKING 

When the EX7000 is unpacked from its shipping carton, the contents should include the following 
items: 

• EX7000 series instrument 
• LXI Quick Start Guide 
• EX7000 Series User’s Manual (this manual) 
• VTEX Switch Driver Programmer’s Manual 
• VTI Instruments Corp. Drivers and Product Manuals CD 
• Power line cord 

All components should be immediately inspected for damage upon receipt of the unit. 

INSTALLATION LOCATION 

The EX7000 is designed to be largely insensitive to external electrical, magnetic, and thermal 
disturbances. However, as with all precision instrumentation, certain precautions, if taken into 
consideration, can help achieve maximum performance. 

1) The unit should be located away from sources of extreme high or low temperatures. 
2) The unit should be located away from sources of high magnetic fields such as motors, 

generators, and power transformers. 

The EX71HD, EX72SF, and EX72CC employ active cooling for maximum product reliability. 
The EX7400 may or may not employ such cooling, depending on the expected power 
consumption. When any of the EX7000 family of products is installed into a test fixture, the user 
must ensure that adequate air flow is provided to all components. 
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EX7000 HARDWARE SETUP 

To properly set up the EX7000 for use, the following cabling connections must be made: 

• The ac power cord, supplied with the EX7000 must be plugged into any standard ac outlet 
providing 90 V ac to 264 V ac at 47 Hz to 63 Hz. 

• A connection between the Host PC/LAN Switch and the EX7000 LAN port must be made. 
An unshielded Cat 5e Ethernet cable of less than 100 m in length should be used to make this 
connection. The EX7000 is auto-MDIX capable, making crossover cables unnecessary. Note, 
this cable is not provided with the EX7000. 

 

FIGURE 2-1: EX7000 CABLING DIAGRAM 

SOFTWARE INSTALLATION 

The fastest way to begin controlling an EX7000 is to discover the unit using VTI’s LAN 
Instrument Connection and Upgrade (or LInC-U) utility and then manipulate the instrument’s 
Java-based SFP. To do this, the following is required: 

• A PC or laptop computer 
• Microsoft™ Windows™ XP OS with Service Pack 2 (SP2) and Internet Explorer™ (IE) 
• An internet connection 
• Java™ Runtime Environment (JRE) version 6.0 (or later) 
• VTI’s LInC-U utility 

An executable for installing JRE is available on the VTI Instruments Corp. Drivers and Product 
Manuals CD provided with the EX7000. If JRE is currently installed on the host PC, the software 
installation instruction for this software can be skipped. 

The LInC-U Utility searches for all LAN-based VTI devices on the network and can be found on 
the VTI Instruments Corp. Drivers and Product Manuals CD that shipped with the EX7000 or 
may be downloaded from the VTI Instruments corporate website. This utility leverages Apple’s 
Bonjour plug-in if it is installed on the host PC, but, in its absence, uses the VXI-11 discovery 
protocol. This utility can also be used to upgrade the EX7000’s driver and firmware. For more 
information on using the LInC-U utility, please refer to its online Help file. For more information 
on discovering the EX7000, please refer to Web Page Operation in Section 4. 

http://www.java.com/en/download/windows_manual.jsp
http://www.vtiinstruments.com/
http://developer.apple.com/networking/bonjour/BonjourSDKSetup.exe
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LInC-U Installation 

To install LInC-U as a discovery tool for the EX7000’s embedded webpage, insert the 
VTI Instruments Corp. Drivers and Product Manuals CD into the host PCs CD-ROM and, using 
Windows Explorer, navigate to the <CD-ROM Drive>:\EX Platforms Requisites directory. Next, 
run the VTI_LInC-U_setup.exe program. Once installation begins, simply follow the on-screen 
instructions. 

Java Installation 

Java Runtime Environment (JRE) is required to access the SFP page of the EX7000. Prior to 
installing JRE, ensure that all IE sessions have been closed. To install JRE, insert the 
VTI Instruments Corp. Drivers and Product Manuals CD into the host PCs CD-ROM and, using 
Windows Explorer, navigate to the <CD-ROM Drive>:\EX Platforms Requisites directory. Then 
run the JRESetup.exe program. Once installation begins, simply follow the on-screen 
instructions. 

NETWORK CONFIGURATION 

With its default network configuration, the EX7000 will attempt to locate a DHCP server. If one is 
found, the IP address assigned by the DHCP server will be used. Otherwise, after a timeout of 
20 seconds, the unit will attempt to obtain an IP address by using Auto IP. 

NOTE At any time, the EX7000 can be returned to a known, default network configuration by using the 
LCI (LAN Configuration Initialize) mechanism. See Reset Button for more information. 

Auto IP is a mechanism for finding an unused IP address in the range 169.254.X.Y, where X is in 
the range 1 through 254 and Y is in the range 0 through 255. The device will first attempt to obtain 
the specific address 169.254.X.Y, where X and Y are the second-to-last and last octets (bytes) of 
the device’s MAC address. However, X will be set to 1 if it is 0 in the MAC address, and to 254 if 
it is 255 in the MAC address. This is in accordance with the Auto IP standard (RFC 3927). If this 
address is already in use, the unit will attempt to obtain other IP addresses in a pseudorandom 
fashion until it finds one that is available. 

To illustrate the Auto IP mechanism, Table 2-1 lists the Auto IP default address for some example 
MAC addresses. 

MAC Address Auto IP Default Address 
00:0D:3F:01:00:01 169.254.1.1 
00:0D:3F:01:01:01 169.254.1.1 
00:0D:3F:01:A3:28 169.254.163.40 
00:0D:3F:01:FE:FE 169.254.254.254 
00:0D:3F:01:FF:FE 169.254.254.254 

 

 
TABLE 2-1: AUTO IP DEFAULT ADDRESS ASSIGNMENT 

If a static IP address assignment is preferred, one can be optionally assigned via the embedded 
web page interface. This is done by clicking the Network Configuration link, disabling DHCP 
and Auto IP, enabling Static, and then assigning a static IP address, subnet mask, and gateway 
address, and, optionally up to three DNS servers. For more information, see Network 
Configuration in Section 4. 

NETWORK TROUBLESHOOTING 

If an error occurs when trying to discover the EX7000 (see Web Page Operation Introduction in 
Section 4 for more information on discovery), it may be necessary to change the network settings 
for the EX7000 and the host PC. By using the following methodology, most network-related 
issues can be resolved: 
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1) Restore the EX7000’s Default Network Settings 
2) Determine PCs Network Settings 
3) Set the EX7000 to Auto IP or Set theEX7000 to Static IP 
4) Restore the Host PCs Network Settings 

Restore the EX7000’s Default Network Settings 

It may be the case that the EX7000 is in an unknown network configuration. The EX7000 can be 
returned to its default state by pressing the Reset Button located at the rear of the chassis. 

1) Power off the EX7000. 
2) Press and hold the reset button until the LAN LED flashes green (approximately 5 s). 
3) Release the reset button. 

Determine PCs Network Settings 

1) Ensure that all host PC Ethernet connections are made that will be used while controlling the 
EX7000. If the PC will be connected to a LAN, ensure that the LAN connection is made. 

2) From Windows , navigate to Start-> Settings->Network Connections. 
3) Right click on the connection that will be used to communicate with the EX7000, then select 

Properties (see Figure 2-2). Some PCs have multiple network connections, so it is important 
to make certain that the connection used to communicate with the EX7000 is selected. 

 

FIGURE 2-2: NETWORK CONNECTION PROPERTIES 

4) Select Internet Protocol (TCP/IP), then click the Properties button as shown in Figure 2-3. 

 

FIGURE 2-3: LOCAL AREA CONNECTION PROPERTIES DIALOG BOX 



www.vtiinstruments.com 

EX7000 Series Preparation for Use 21 

5) Determine if the PC is set to use auto or static IP. Figure 2-4 shows examples of both auto and 
static IP address configurations. 

      

FIGURE 2-4: DYNAMIC (LEFT) AND STATIC (RIGHT) IP ADDRESS CONFIGURATIONS 

6) If set to use a static IP, record the IP address, subnet mask, and default gateway for use later. 
Select Obtain an IP address automatically to establish a connection to the EX7000. Click 
the OK button and proceed to Set theEX7000 to Static IP. If set to use a dynamic IP, click the 
OK button and proceed to Set the EX7000 to Auto IP. 

Set the EX7000 to Auto IP 

1) Remove all network connections from the PC except for the connection to the EX7000. 
Wireless adapters should be disabled as well. 

2) Apply power to the EX7000 and wait for the LAN LED to turn green. 
3) Discover EX7000 using Bonjour as described in the Web Page Operation Introduction in 

Section 4. The steps taken previously should ensure that discovery works. 
4) Once connected to the EX7000, click on Network Configuration in the command menu. 
5) Select DHCP and AutoIP in the IP Address Source field and ensure that Static IP is not 

selected. Figure 2-5 shows the proper configuration. Click the Submit button to save all 
changes. 

 

FIGURE 2-5: EX7000 SET TO USE AUTO IP 
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Set theEX7000 to Static IP 

1) Disconnect all network connections from the PC except for the connection between the PC 
and the EX7000. 

2) Apply power to the EX7000 and wait for the LAN LED to turn green. 
3) Discover EX7000 using Bonjour as described in the Section 4, Web Page Operation. The 

steps taken previously should ensure that discovery works. 
4) Once connected to the embedded web interface, click on the Network Configuration link in 

the command menu. 
5) Select the Static checkbox in the IP Address Source field and ensure that DHCP and 

AutoIP are not selected. 
6) In the IP Address field, enter an appropriate IP address for the EX7000. Use the IP address 

obtained the Determine PCs Network Settings step to determine the network address. The 
network address is the first three digits of the IP address (10.1.0 in the example provided). 
The last digit of the IP address (the node), is a number, 0 through 255, that is not currently 
assigned to any other device on the network. Ensure that a unique IP address is assigned to the 
EX7000 by consulting a network administrator. 

7) In the Subnet Mask field, enter the subnet mask in the Determine PCs Network Settings step. 
8) In the Gateway Address field, enter the same gateway address in the Determine PCs Network 

Settings step. 
9) Click Submit to save all changes made to the Network Configuration page. 

 

FIGURE 2-6: EX7000 SET TO USE STATIC IP 

Restore the Host PCs Network Settings 

1) Power down the EX7000 and reconnect it to the LAN in its desired location. 
2) If the PC was originally set to use a static IP address, use the procedure in Determine PCs 

Network Settings to change the PCs IP address back to it original state. 
3) Power on the EX7000 and wait for the LAN LED to turn solid green. 
4) Discover the EX7000 using Bonjour as described in Section 4, Web Page Operation. 
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DRIVER INSTALLATION 

To monitor and/or control the EX7000’s instruments programmatically (via a user generated 
program or through tools such as HP VEE, National Instrument’s Switch Executive, etc.), two 
additional components must be installed: the IVI Shared Components library and the provided 
VTI Instruments instrument driver. Follow these steps: 

IVI Shared Components Installation 

If this component was installed during a previous LXI instrument installation, please proceed to 
Switch Instrument Driver Installation. First, close all other open programs, leaving only Windows 
Explorer open. Navigate to the <CD-ROM Drive>:\EX Platform Requisites directory on the CD 
and run the IVISharedComponents1.5.0.exe program. Next, follow the on-screen instructions. 
Do not proceed to the next step until this installation completes successfully. If instructed to 
reboot the PC, it will be necessary to do so at that time. 

Switch Instrument Driver Installation 

If the VTEXSwitch instrument driver was installed previously on the host PC, proceed to 
System/LXISync Instrument Driver Installation. To install the VTEXSwitch instrument driver, 
navigate to <CD-ROM Drive>:\LXI Drivers\EX Switch Driver, IVI on the CD and run the .msi 
installer located in this directory. 

System/LXISync Instrument Driver Installation 

NOTE Complete this step only if the LXISync capabilities of the EX7000 platform are required. Also, if 
this driver was installed previously on the host PC, software installation is now complete. 

To install the System/LXISync Instrument driver, navigate to <CD-ROM Drive>:\LXI Drivers\EX 
System Driver, IVI on the CD and run the .msi installer located in this directory. 

Please refer to VTEX Switch Driver Programmer’s Manual for programming guidelines. 
Additional information about IVI drivers can be found on the web at http://ivifoundation.org. 
Information about the LXI standard and LXI technology can be found at 
http://www.lxistandard.org. 

http://ivifoundation.org/
http://www.lxistandard.org/
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 SECTION 3 

BASIC OPERATION 
INTRODUCTION 

The EX7000 Series modular microwave switch assemblies require only ac power and a LAN 
connection to a PC or network. The PC must have an Internet browser, such as Internet Explorer 
or Firefox, installed. The embedded web page in each EX7000 allows easy access and control of 
the internal microwave components. 

REAR PANEL VIEW 

The rear panel of the EX7000 contains an ac power entry module, an ac power switch, an Ethernet 
10/100 Base-T connection, a general purpose digital IO connections (on the EX72SF), 
LXI Trigger Bus connectors, and access to the reset button. Figure 3-1 shows a typical rear panel, 
in this case, of an EX72SF. 

TRIGGER BUS 
DIGITAL I/O 

RESET 

ETHERNET 

10/100 BASE-T 

90-264 VAC 
50 /  60 Hz 

25VA M AX.  

GP I/O 

VTIMicrowave

 

FIGURE 3-1: EX72SF REAR PANEL VIEW 

The rear panel of the EX7400 may have coaxial connectors. Their type, quantity, and location are 
a function of the customer’s requirements. 
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Trigger Bus Connectors 

The EX7000 provides an LXI compatible trigger bus connector set on the rear panel of the 
instrument. Both connectors have the same pin assignments and are wired in parallel. For more 
information on the LXI Trigger Bus and creating an appropriate cable, please visit 
www.lxistandard.org and refer to LXI Standard Revision 1.2 and LXI Trigger Bus Cable and 
Terminator Specifications Rev 1.1. 

Trigger Bus Connectors 
Pin Signal Pin Signal 
1 +3.3 V 14 RP_TRIG_P0 
2 GND 15 RP_TRIG_N0 
3 RP_TRIG_P1 16 RESERVED 
4 RP_TRIG_N1 17 RP_TRIG_P2 
5 GND 18 RP_TRIG_N2 
6 RP_TRIG_P3 19 GND 
7 RP_TRIG_N3 20 RP_TRIG_P4 
8 GND 21 RP_TRIG_N4 
9 RP_TRIG_P5 22 GND 
10 RP_TRIG_N5 23 RP_TRIG_P6 
11 RESERVED 24 RP_TRIG_N6 
12 RP_TRIG_P7 25 RESERVED 
13 RP_TRIG_N7   

1 13

14 25 
 

 
Digital I/O Connector 

The EX7000 features an 8-channel digital I/O port on the rear panel of the instrument. This port 
can be used as a trigger source and as a general purpose output device. The digital I/O connector is 
a standard DB-9 with the following pin assignments: 

Digital IO Connector 
Pin Signal Pin Signal 
1 DIO Channel 0 2 DIO Channel 1 
3 DIO Channel 2 4 DIO Channel 3 
5 DIO Channel 4 6 DIO Channel 5 
7 DIO Channel 6 8 DIO Channel 7 
9 GND   

9

5

6

1

 
Mating Connector: Tyco 5-747904-2 

 

 
As a general purpose output device, each DIO channel can be independently programmed with 
regards to its output functionality and its static level to assume when enabled as an output. When 
not enabled as an output, a channel becomes tri-stated, preventing conflict with other potential 
voltage drivers. Reference the port’s electrical specifications in Table 3-1 for voltage tolerance 
limits and output drive capabilities. Regardless of output functionality, each channel provides 
constant input functionality. That is, the input level on each channel can be accessed without a 
specific enable command. Moreover, the base functionality of the DIO channels is not affected by 
triggering, scanning, or any other instrument process. 

http://www.lxistandard.org/
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When enabled as an output, each channel also has the ability to generate a 1 µs pulse upon 
command. An example application of this pulse is to use the EX7000 to externally trigger another 
piece of test equipment. The specific operation of the pulse depends on the static level 
programmed for that channel. When a channel is programmed with a static level of high, the pulse 
will be low-going. When a channel is programmed with a static level of low, the pulse will be 
high-going. Each pulse generation requires a separate command. 

The electrical specifications for the digital I/O port are provided in Table 3-1. Particular note 
should be given to the VINPUT specification of -0.5 V to 5.5 V. Exceeding that value with an 
external voltage source, even through a resistance, could permanently damage the EX7000. 

Characteristic Value 
VINPUT -0.5 V to 5.5 V 

VIH 2 V min 
VIL 0.8 V max 

VOH (IOH = -32 mA) 2 V min 
VOL (IOL = 64 mA) 0.55 V max 

 

 
TABLE 3-1: DIGITAL I/O PORT ELECTRICAL SPECIFICATIONS 

General Purpose I/O 

The EX72SF features an additional 32-bit general purpose TTL I/O port. This is in additional to 
the internal 72-channel relay drivers and the 8-bit digital I/O described above. The following are 
the pin assignments for the rear-mounted 37-pin D-sub connector: 

Pin Signal Pin Signal 
1 GND 20 PIO-PORT0 
2 PIO-PORT1 21 PIO-PORT2 
3 PIO-PORT3 22 PIO-PORT4 
4 PIO-PORT5 23 PIO-PORT6 
5 PIO-PORT7 24 PIO-PORT8 
6 PIO-PORT9 25 PIO-PORT10 
7 PIO-PORT11 26 PIO-PORT12 
8 PIO-PORT13 27 PIO-PORT14 
9 PIO-PORT15 28 GND 
10 +5 V 29 GND 
11 PIO-PORT16 30 PIO-PORT17 
12 PIO-PORT18 31 PIO-PORT19 
13 PIO-PORT20 32 PIO-PORT21 
14 PIO-PORT22 33 PIO-PORT23 
15 PIO-PORT24 34 PIO-PORT25 
16 PIO-PORT26 35 PIO-PORT27 
17 PIO-PORT28 36 PIO-PORT29 
18 PIO-PORT30 37 PIO-PORT31 
19 GND   

 
 

 
A current limited supply of +5 V is provided on pin 10. An internal, resettable fuse is provided to 
protect 200 mA against excessive current flow and short circuits. 
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Reset Button 

The reset button, accessible through a hole in the rear panel of the EX7000, implemented 
according to the LXI LAN Configuration Initialize (LCI) Mechanism specification, can be used to 
restore default network settings. This is useful for recovery from an incorrect or unknown network 
configuration. There are three modes of operation for this button which are based on the time the 
reset button has been depressed. 

Debounce Protection Mode 

To prevent unintentional resets of the EX7000, there is a short (< 1 s) debounce protection 
mechanism. If the reset switch is depressed for less 1 s, the activation of the reset button is treated 
as unintentional and no action is taken. 

Device Reset Mode 

Depressing the switch for a longer time (greater than 1 s but less than or equal to 10 s) causes the 
EX7000 to reset in the same manner as clicking the Reset button on the webpage. All switch 
modules, for instance, will move their switches to the predefined “reset” state. There is no visual 
indicator for this reset. 

Device Reboot/LCI Reset Mode 

To perform an LCI reset and an immediate reboot of the EX7000, depress the reset button for 
longer than 10 s, wait for the LAN LED to flash red, then release the button. This will return the 
EX7000 to the power-on default state. The network configuration will be restored to factory 
defaults in accordance with the LCI reset procedure described in the LXI Specification. 

The EX7000 will now revert back to the default network configuration (DHCP and Auto IP 
enabled) instead of its previous settings. VXI-11 Discovery (supported by the VISA IO-Libraries) 
can be used to determine the IP address of the instrument. 

FRONT PANEL VIEW 

The front panel of each EX7000 model is different. The EX71HD front panel is configured with 
twelve identical mounting locations for miniature microwave switch modules. The EX72SF front 
panel is configured with twelve locations for latching microwave switches. The twelve locations 
are divided into six locations for SPDT switches and six locations for SPnT and/or transfer 
switches. The EX7400 will be configured to satisfy its unique customer specified requirements. 
Details for each EX7400 are supplied as supplements to this manual. 

EX71HD 

The EX71HD enclosure, shown in Figure 1-1, and switch modules are fitted with blind mating 
connectors to simplify switch module removal and installation. The mounting plate on the 
switches contains two rear facing alignment pins that fit into holes on the front panel. These pins 
only allow full insertion of the switch into the EX71HD enclosure opening when properly aligned. 

NOTE Before proceeding with the removal and/or installation of any microwave switch modules in any 
of the EX7000 Series assemblies, turn the ac power switch to the OFF position and remove the ac 
power cord. 

To remove a switch from the enclosure, simply remove the four miniature hex head cap screws 
from the four corners of the switch using a 5/64” hex key wrench and pull the switch forward. 
There will be some slight resistance until the blind mate connectors disengage. 
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Installation is in the reverse order. Carefully insert the multi-pin connector end of the switch into 
the opening, turning the switch module to arrange the two alignment pins to be on the top side of 
the switch. Insert straight back until the blind mating connector alignment pins engage. Once these 
alignment pins are engaged, press firmly until the switch slides in flush with the EX71HD front 
panel. Insert and tighten the four 2-56 hex head cap screws. 

Following the mechanical installation, the EX72HD needs to have its DCF updated. This will not 
be necessary for cases where a switch is simply replaced with another of the same model. The 
DCF tells the internal control and drive circuitry exactly what is connected to each port of the unit. 
Updating the DCF is accomplished by running the System Configurator and following the 
intuitive prompts. See Appendix A for more details on using the System Configurator. 
Alternatively, the new DCF can be generated by the factory and downloaded over the Internet. 
Consult the factory for details. 

EX72SF 

The EX7SF enclosure , shown in Figure 1-2,can accommodate a large number and various types 
of Agilent latching switch modules. The upper six switch mounting locations, designated SW1 to 
SW6, are designed for SPDT switches. The lower six switch mounting locations, designated SW7 
to SW12, are designed for SP4T, SP6T, and transfer switches. 

The following table provides the switch model choices for these sections: 

VTI MODEL DESCRIPTION  AGILENT MODEL NUMBER 
SPDT (SW 1 – 6)   
7200-2P 6 line, SPDT, pass- through adapter N/A 
7202-20 SPDT, 20 GHz 8765B 
7202-26 SPDT, 26 GHz 8765C 
7202-20T SPDT, T, 20 GHz 8762B 
7202-26T SPDT, T, 26 GHz 8762C 
7202-20EL SPDT, EL, 20 GHz N1810UL-020 
7202-26EL SPDT, EL, 26 GHz N1810UL-026 
7202-20TEL SPDT, T, EL, 20 GHz N1810TL-020 
7202-26TEL SPDT, T, EL, 26 GHz N1810TL-026 
SP4T (SW7-12)   
7200-6P 6 line, SPnT, pass-through adapter N/A 
7204-20 SP4T, 20 GHz L7204B 
7204-26 SP4T, 26 GHz L7204C 
7204-20T SP4T, T, 20 GHz L7104B 
7204-26T SP4T, T, 26 GHz L7104C 
7204-20TEL SP4T, T, EL, 20 GHz 87104B 
7204-26TEL SP4T, T, EL, 26 GHz 87104C 
SP6T (SW7-12)   
7206-20 SP6T, 20 GHz L7206B 
7206-26 SP6T, 26 GHz L7206C 
7206-20T SP6T, T, 20 GHz L7106B 
7206-26T SP6T, T, 26 GHz L7106C 
7206-20TEL SP6T, T, EL, 20 GHz 87106B 
7206-26TEL SP6T, T, EL, 26 GHz 87106C 
Transfer (SW7-12)   
7222-26 Transfer, 26 GHz L7222C 
87222-26 Transfer, EL, 26 GHz 87222C 

 

 
TABLE 3-2: EX72SF SWITCH MODULES 

The SPDT switches are mounted on special carriers for installation into the EX72SF and are 
delivered this way if ordered separately from the factory. The SP4T and SP6T switches mount 
directly in the lower openings and do not require any special carriers. The transfer switches do not 
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have the same square mounting plate as the multi-throw switches so they require a special carrier 
for mounting in the lower round openings. 

NOTE Before proceeding with the removal and/or installation of any microwave switch modules in an 
EX7000, turn the ac power switch to the OFF position and remove the ac power cord. 

To remove a SPDT switch from the enclosure, simply remove the two pan head Philips screws 
from each side of the individual switch faceplate. Remove the faceplate and slide the switch 
forward until it is away from the enclosure and far enough out to expose the white plastic 8-pin in-
line connector. Firmly grasp each end of the white plastic body, squeezing the release tab on the 
enclosure side and pull until the two parts separate. 

NOTE The new switch modules must have the cable assembly with the white plastic multi-pin connector 
installed in order for it to interface with the internal control circuitry. All replacement or add-on 
relays supplied by VTI Microwave will have this cable in place. Contact VTI Microwave 
immediately if your switch module arrives without this cable assembly as well as the universal 
mounting carrier installed. 

Installation is in the reverse order. Carefully insert the multi-pin white plastic connector, at the end 
of the switch module cable, into the mating cable extending from the EX72SF enclosure opening. 
Press the two plastic connectors firmly together until you can feel slight clicking action as the 
release tab on the enclosure side connector drops into place, locking the two connectors together. 
Next, align the sides of the carrier with the dark plastic card guides on each side of the rectangular 
opening. Slide the switch and carrier all the way in until it reaches the rear stop which should 
place the front body of the connector approximately flush with the front panel of the enclosure. 
Place the faceplate back in position and secure with the two pan head Philips screws. 

To remove a SP4T or SP6T switches from the enclosure, simply remove the four flat head Philips 
screws from each corner of the switch. Slide the switch forward until it is away from the enclosure 
and far enough out to access the 16 pin ribbon cable connector plugged into the rear of the switch. 
Pull the release tab on the rear of the switch away from the connector and pull the ribbon cable 
connector out of the switch. 

Installation is in the reverse order. Carefully insert the ribbon cable connector into the mating 
connector on the switch module. Align the ribbon cable connector tab with the release tab on the 
switch’s connector. Press the ribbon cable connector firmly in until the release tab on the switch 
clicks into place locking the connector in place. Slide the switch all the way in until it the 
mounting flange is flush with the front panel of the enclosure. The switch can operate in any 
orientation but the standard configuration is for the #1 port to be closest to the right side of the 
enclosure which puts port 5 and 6 at the top. Align the four holes and secure with the four flat 
head Philips head screws. 

Following the mechanical installation, the EX72SF needs to have its DFC updated. This will not 
be necessary for cases where a switch is simply replaced with another of the same model. The 
DCF tells the internal control and drive circuitry exactly what is connected to each port of the unit. 
Updating the DCF is accomplished by running the System Configurator and following the 
intuitive prompts (see Appendix A for more details). Alternatively, the new DCF can be generated 
by the factory and downloaded over the Internet. Consult the factory for details. 

EX72CC 

The EX72CC can be configured in many different ways much like the EX72SF. However, the 
EX72CC can accommodate a much wider range of SPDT and SPnT switches from various 
manufacturers. Please contact your local VTI sales rep to discuss the options available. The only 
restrictions to be considered are size (SPnT limited to 2.25” square face plates), an operating 
voltage of 12V and non-latching operation.    



www.vtiinstruments.com 

EX7000 Series Basic Operation 31 

EX7400 

Generally speaking, most EX7400 models will have their switches mounted internally and are not 
intended for easy field upgrades or repairs. Please contact the VTI Microwave in the event of a 
failure. 
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 SECTION 4 

WEB PAGE OPERATION 
INTRODUCTION 

To open the embedded web page, start the LInC-U utility by navigating to Start → Programs → 
VTI Instruments Corporation → LInC-U Utility → LInC-U Utility. Once the utility is run, 
LInC-U will scan the network to discover all LAN-based VTI instruments. Once the scan is 
complete, the Discovery Devices tab will appear and show the instruments that were discovered, 
as shown in Figure 4-1. To open the web page, click on the hostname hyperlink on the Discover 
Devices tab. The IP address of the EX7000 can also be viewed from this window as well as its 
firmware version. 

 

FIGURE 4-1: LINC-U DISCOVERY TAB WITH EX7000 SELECTED 

Alternatively, the EX7000 may also be discovered using Internet Explorer’s Bonjour for Windows 
plug-in. The IP address of the EX7000 can also be entered into the address bar of any web browser 
to view the embedded web page. By default, the EX7000 will first attempt to use DHCP to set its 
IP Address. If DHCP is not available on the network it is connected to, it will instead use Auto IP. 
Determining the Auto IP address is discussed in the Network Configuration discussion in 
Section 2. Other discovery methods, such as VXI-11, can be used as well 
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GENERAL WEB PAGE OPERATION 

When initial connection is made to the EX7000, the instrument home page, Index, appears (see 
Error! Reference source not found.). This page displays instrument-specific information 
including: 

• Model 
• Manufacturer 
• Serial Number 
• Description 
• LXI Class 
• LXI Version 
• Hostname 
• MAC Address 
• IP Address 
• Netmask 
• Firmware Version 
• IEEE-1588 Time 

 

FIGURE 4-2: EX7000 MAIN WEB PAGE 

The Index is accessible from any other instrument page by clicking on the EX7000 web page 
header. The EX7000 command menu is displayed on the left-hand side of every internal web page. 
The entries on the command menu represent three types of pages: 

Status This type of page performs no action and accepts no entries. It provides operational 
status and information only. The Index page is an example of a status page. 

Action This type of page initiates a command on the instrument, but does not involve 
parameter entry. The Reboot page is an example of an action page. 
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Entry This type of page displays and accepts changes to the configuration of the instrument. 
The Time Configuration page is an example of an entry page. 

Use of the entry-type web pages in the EX7000 are governed by a common set of operational 
characteristics: 

• Pages initially load with the currently-entered selections displayed. 
• Each page contains a Submit button to accept newly entered changes. Leaving a page before 

submitting any changes has the effect of canceling the changes, leaving the instrument in its 
original state. 

• Navigation through a parameter screen is done with the Tab key. The Enter key has the same 
function as clicking the Submit button and cannot be used for navigation. 

Password Protection 

Once connected to the EX7000, the user should define a password. No password is defined by 
default. To create a password, click on the Change Password link in the command menu, then 
enter the desired password in both text fields. From this point forward, pages that modify 
instrument configuration (e.g., SFP) require this password to initially login. It is only necessary to 
enter a password once per session. 

 

FIGURE 4-3: EX7000 PASSWORD PAGE 

NOTES 1) The instrument password uses lower-case letters. 
 2) This password mechanism provides only the most basic security. Applications requiring 

 additional security should consider using private, dedicated subnets, firewalls, etc. to limit 
 access to the instrument on the network. 

VTI Instruments Logo 

The VTI Instruments logo that appears on the upper left of all EX7000 web pages is a link to the 
VTI Instruments Corp. corporate website: http://www.vxitech.com. 

EX7000 Title Block 

The title block (“EX7000” on a black background at the top of the page) of all EX7000 web pages 
is a link to the Main Web Page. 

http://www.vxitech.com/
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SOFT FRONT PANEL 

An example of the EX7000 SFP page can be seen in Figure 4-4. By accessing this page, the 
various switch modules, attenuators, and other devices connected to the EX7000 can be viewed, 
identified, and commanded. 

Monitor and Control Tab 

By default, the SFP opens to the Monitor and Control view. From this view, the user can see the 
RF devices installed in the EX7000. To control a switch, for example, simply click on the pin that 
needs to be activated to cause the internal relay to actuate and connect to the pin indicated. For 
other RF devices, certain values may need to be entered or selected in order for them to perform as 
required. Horizontal and vertical scroll bars allow the user to navigate larger systems by scrolling. 
The user may also change the size of the schematic. Near the upper right corner of the web page is 
a size selection menu. By clicking on either the up or down arrow, the size of the schematic can be 
changed from to any of the following sizes: Tiny, Small, Medium (default), and Large. 

 

FIGURE 4-4: EX7000 SOFT FRONT PANEL PAGE 

For switches that support read-back, the ports are color coded to provide the user an indication of 
the relay states. The Color Legend provides the meaning of each color. Dark blue ports have 
been commanded closed. This color should appear each time a port is selected and working 
properly. A light blue port may be found on a latching relay. It indicates that, although the port 
has not been commanded closed, read-back indicates that it is closed. If a port turns red after 
being commanded, this indicates that the switch has failed to close and may require repair. For 
switches that do not read-back, ports will appear dark blue for all states. 

The main toolbar of the SFP provides the following functionality: 

• Control Mode: Three control modes are available for EX7000 modules. 
o Monitor Only: In this mode, the user can view the actions the various EX7000 

components while the module is actively performing automated test. The image is 
refreshed every 3 s. In this mode, no modifications can be made. If a another user has 
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established a session with the EX7000, all other sessions established after that will be 
“Monitor Only” sessions until the previous session has ended. 

o Synchronous Mode: In this mode, the user can manipulate the RF components in the 
EX7000 in real time. As the user clicks a port or sets a value and it affects the EX7000 at 
that time. 

o Asynchronous Mode: In this mode, the user may manipulate all RF components, but the 
actions do not occur until after the Apply button is clicked. Clicking on the Revert 
button will cause the RF components to revert to the state they were in the last time 
Apply was clicked. 

• Save/Load/Erase: These functions allow the user to either save, load, or erase a switch 
configuration. Saving a state allows the user to use the same switch set up at a later time. 
When the Save button is clicked, a prompt will appear. The user selects a number, 0 through 
127, from this field. Click OK to save the current state as the state number entered. To load or 
erase a saved state, simply click on the Load or Erase button, select the desired state number 
from the dialog box that appears, and then click OK. 

Switches are typically identified with an “SW” number located in the upper-left corner (and upper-
right corner for dual SPDT switches). If this indicator is clicked, a switch information menu 
appears. From this menu, the user can determine the switch type, view specifications, and monitor 
switch life using the odometer feature. Odometer information is stored on the controller card, so, if 
a switch is moved from one slot to another, it is necessary to enter the correct odometer 
information initially. This is done by entering the correct number of actuations into the Position 
entry field and then clicking on the Set Odometers button. 

 

FIGURE 4-5: SWITCH INFORMATION MENU (RIGHT) 
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Device Info Tab 

If the Device Info tab is clicked, information regarding the EX7000 mainframe is available as well 
as the version of the SFP, firmware, and configuration. 

 

FIGURE 4-6: DEVICE INFORMATION WEB PAGE 

NETWORK CONFIGURATION 

The EX7000 Network Configuration page can be seen in Figure 4-7. By default, the EX7000 
will attempt to locate a DHCP server. If one is found, the IP address assigned by the DHCP server 
will be assumed, along with subnet masks, gateway, etc. Otherwise, after a timeout of 20 seconds, 
the unit will attempt to obtain an IP address by using Auto IP (IPv4 Dynamic Link Local 
Addressing). 

NOTE The EX7000 can be returned to a known, default network configuration by using the LCI (LAN 
Configuration Initialize) Mechanism. See Reset Button for more information. 

Auto IP is a mechanism for finding an unused IP address in the IANA assigned range 
169.254.X.Y (169.254/16) where X is in the range 1 to 254 and Y is in the range 0 to 255. The 
device will first attempt to obtain the specific address 169.254.X.Y, where X and Y are the 
second-to-last and last octets of the device’s MAC address. However, X will be set to 1 if it is 0 in 
the MAC address, and to 254 if it is 255 in the MAC address for conformance with the Auto IP 
specifications. If this address is already in use, the unit will attempt to obtain other IP addresses in 
the 169.254/16 range in a pseudorandom fashion until it finds one that is available. 

To illustrate the Auto IP mechanism, Table 4-1 lists the Auto IP default address for some example 
MAC addresses. 

MAC Address Auto IP Default Address 
00:0D:3F:01:00:01 169.254.1.1 
00:0D:3F:01:01:01 169.254.1.1 
00:0D:3F:01:A3:28 169.254.163.40 
00:0D:3F:01:FE:FE 169.254.254.254 
00:0D:3F:01:FF:FE 169.254.254.254 

 

 
TABLE 4-1: AUTO IP DEFAULT ADDRESS ASSIGNMENT 
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If a static IP address assignment is preferred, one can be optionally assigned via the embedded 
web page interface. This is done by clicking the Network Configuration link, disabling DHCP 
and Auto IP, enabling Static, and then assigning a static IP address, subnet mask, and gateway 
address, and, optionally, up to three DNS servers (see Figure 4-7). 

NOTE The 169.254/16 subnet is reserved by the IANA for Auto IP usage. It should not be used for either 
DHCP or static IP configurations. 

However, a much more convenient and recommended way to obtain the benefits of a static IP 
address is to employ DHCP, but assign the instrument a reserved IP address in your company’s 
DHCP server configuration. This reserved address, linked to the EX7000’s MAC address on the 
DHCP server, would be assigned to the EX7000 at power up initialization without having to 
manually set it on the EX7000. The DHCP server configuration provides a centralized, controlled 
database of assigned IP addresses, preventing accidental assignment of the same IP address to 
multiple instruments. Consult your company’s Information Technology department for assistance. 

VXI-11 Device Discovery is also supported by the EX7000. This allows all EX7000s on a local 
network to be found without knowledge of their MAC address or IP address with the use of a 
broadcast message. 

 

FIGURE 4-7: EX7000 NETWORK CONFIGURATION 
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NOTE If problems are experienced connecting to the EX7000, please refer to the Network 
Troubleshooting process in Section 2. 

TIME CONFIGURATION 

This entry page is used to change the time configuration of the EX7000. As the EX7000 has no 
notion of “wall clock” or calendar time and no battery-backed clock or any other mechanism to 
retain time between reboots and power-cycles, the time must be set by the user. By default, the 
instrument’s time and date at power-up are midnight, January 1, 1970 (the beginning of the 
“epoch”). Three time source options are provided: PTP (Precision Time Protocol or IEEE 1588 
synchronization), SNTP (simple network time protocol), or manual. The default time source is 
PTP (see Figure 4-8). 

 

FIGURE 4-8: EX7000 TIME CONFIGURATION WEB PAGE – DEFAULT 

• Time Zone: allows the user to select an appropriate time zone. 
• Time Source: allows the user to set the EX7000s date by entering the month (MM), day 

(DD), and year (YYYY), respectively. 
• Set Time: allows the user to set the EX7000s time by entering the hour (HH), minute (MM), 

and second (SS), respectively. If the EX7000 is set as an IEEE 1588 Master, the hour should 
be entered using the 24-hour format. 

• Time Status: this section of the web page provides the mainframe’s current time 
configuration settings. 

Selecting SNTP from the Time Source menu, the EX7000 can synchronized with an SNTP 
server. The Time Zone drop menu allows the user to select the local time zone. SNTP or NTP 
(Network Time Protocol) servers are specified in the NTP Servers field, by IP address or 
hostname. Once configured, the user must click Submit in order for the changes to take affect. 
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FIGURE 4-9: SNTP CONFIGURATION PAGE 

NOTE Specifying SNTP or NTP servers by hostname requires that the instrument be set to DNS, either 
by DHCP or Static IP. 

If a PTP master or an SNTP server is not available, time can be configured manually by the user 
by selecting Manual in the Time Source drop menu, clicking the Set Time checkbox, and then 
entering the time appropriately. Once the time information has been entered, click the Submit 
button. An instrument reboot is then required to activate the new selection. 

LXI SYNCHRONIZATION 

The LXI Synchronization status page provides information about the EX7000s synchronization 
characteristics. Note that PTP must be selected in the Time Configuration web page in order for 
this page to be populated as see in Figure 4-10. 

For more information, please refer to LXI Standard Revision 1.2, Section 9, Rule 9.6. and 
IEEE 1588-2002, Precision Clock Synchronization Protocol for Networked Measurement and 
Control Systems. 
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FIGURE 4-10: LXI SYNCHRONIZATION WEB PAGE 

• IEEE 1588 Parameters 
o PTP Grandmaster Clock MAC: indicates the MAC address of the device on the 

network to which all other IEEE 1588 compliant devices are synchronized. 
o PTP Parent Clock MAC: indicates the MAC address of the device to which the EX7000 

is synchronized. On a LAN that consists of multiple subnets, this indicates the MAC 
address of the parent clock on that particular subnet. 

o PTP State: indicates whether the EX7000 is a master, slave, faulty, disabled, passive, or 
unlocked. 

o Current PTP Time: indicates the number of seconds since midnight January 1, 1970 
UTC (coordinated universal time). 

o Current Local Time: indicates the date and time (in 24-hour format). 
o Grandmaster Traceability to UTC: indicates how the grandmaster is synchronized to 

the UTC. The values provide an indicator of how closely synchronized the grandmaster is 
to UTC time. 

Value Clock Source UTC Synchronization 
ATOM UTC Atomic Clock Less than 100 ns 

GPS GPS Receiver Less than 100 ns 
NTP Network Time Protocol Less than 50 ms 

HAND Manually/Automatically Set Less than 10 s 
INIT User Defined Not specified 

DFLT None None 
 

 
TABLE 4-2: UTC GRANDMASTER CLOCK IDENTIFIERS 

o Current Variance of Parent: this function not currently supported by the EX7000. 
o IEEE 1588 Domain: indicates the instrument’s PTP subdomain. Typically, this indicator 

is _DFLT. 
• LXI Module to Module Parameters 

o LXI Domain: an 8-bit number, 0 to 255, that indicates the domain the EX7000 is using 
for LAN events. All events sent by this device will include this data. Likewise, the device 
will only accept events that include the same LXI Domain data. 

• Wired Trigger Parameters 
o Wired-OR Bias: indicates whether the Wired-OR bias for each Trigger Bus channel 

(LXI0 through LXI7) is enabled or disabled. 
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DEVICE IDENTIFY 

This action page is used to identify the EX7000 that is being commanded in the current session. 
When the Turn on button is pressed, the LAN LED located on the front panel of the EX7000 will 
blink. When the Turn off button is pressed, the LAN LED returns to its normal operation. 

 

FIGURE 4-11: DEVICE IDENTIFY WEB PAGE 

UPGRADE 

This action page is used to upgrade the embedded firmware of the EX7000. Prior to initiating the 
firmware upgrade process, a new, uncompressed firmware image must be obtained from 
VTI Instruments and be accessible from the computer that is connected to the EX7000. Unless 
specifically noted by VTI Instruments, firmware upgrades do not alter the non-volatile 
configuration settings (network configuration, time configuration) of the EX7000. 

NOTE Do not power cycle the EX7000 during the firmware upgrade process. If power is lost during the 
upgrade, the instrument may be put into an inoperable state, requiring return to the factory. An 
uninterruptible power supply may be used to avoid this risk. 

 

FIGURE 4-12: UPGRADE WEB PAGE 
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Perform the following steps to conduct a firmware upgrade: 

1) Delete cookies from Internet browser. 
2) Delete Java cache on host PC. 
3) Perform a Reboot or a power cycle. 
4) Connect to the EX7000 via the embedded web page. 
5) Click on the Upgrade link. 
6) Click on the Browse button and select the firmware image file to be uploaded to the 

instrument. 
7) Click the Submit button to initiate the upgrade process. 

The upgrade process takes approximately 5 minutes to complete and will be followed by a prompt 
to reboot the instrument. Once the reboot is complete, reconnect and confirm on the Index page 
that the firmware revision level has been properly updated. 

Removing Temporary Internet Files 

The initial steps of firmware upgrade involve preparing the host PC. The instructions that follow 
provide guidance for removing cookies from IE and clearing the cache retained by Java. 

Clearing Cookies from Internet Explorer 7 

For Internet Explorer 7, the following steps can be taken to delete existing cookies (for other 
browsers, please refer to the browser’s online help documentation): 

1) Open Internet Explorer. 
2) Click on the Tools icon and select Internet Options from the drop menu. 
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3) When the Internet Options window appears, click on the Delete button in the Browsing 
history section. 

 

4) When the Delete Browsing History window appears, click on the Delete cookies… button. A 
confirmation dialog box will appear. Click the Yes button to remove the cookies present on 
the host PC. 
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Clearing Java Cache 

Once the cookies have been deleted from the host PC, the Java cache should be deleted next. For 
Java version 6, the cache can be removed by performing the following steps: 

1) Navigate to the Control Panel (Start → Settings → Control Panel). 
2) Double click the Java icon in the Control Panel. 

 

3) When the Java Control Panel opens, click on the Settings button in the Temporary 
Internet Files section of the window. 
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4) When the Temporary Internet Files window opens, click the Delete Files… button. A 
confirmation dialog box will appear. Click to OK button delete the cache. 

 

RESET/REBOOT 

The Reset action page is used to return the EX7000 to a known communication state. Pressing the 
Reset button will cause the EX7000 to terminate all active sessions, leaving only the current 
session viable. 

The Reboot action page is used to perform a complete instrument reboot, equivalent to that which 
occurs when the instrument is power cycled. It is most commonly used to accept changes that are 
made to the network configuration or time configuration settings. In addition, it is suggested that a 
reboot be performed before conducting a firmware upgrade. 
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 SECTION 5 

THEORY OF OPERATION 

INTRODUCTION 

This section expands on the description of the internal operation of the EX7000 and explains how 
to best use them. A full understanding of this operation is not required to operate and use the 
EX7000. A functional block diagram is provided below. 

 

FIGURE 5-1: FUNCTIONAL BLOCK DIAGRAM 

SYSTEM OVERVIEW 

Using the drivers provided with the EX7000, commands are issued from the host PC to the DCB. 
The DCB, in turn, controls the operation of the RDBs. Up to eight RDBs can be controlled by one 
DCB, making the EX7000 capable of providing up to 576 high-current relay control drivers, 
96 very high-current drivers, and 256 parallel I/O ports. This is illustrated in Figure 5-1.When 
multiple RDBs exist in an EX7000 system, a rotary switch on the RDB is used to set a unique 
address for each RDB. 
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RDBs can either be commanded one board at a time or several RDBs may be commanded 
simultaneously. The RDB has 72 relay control drive lines capable of sinking 200 mA and twelve 
very high-current reset lines capable of sinking 800 mA. They are divided into three banks, each 
can be powered separately. Each bank consists of four 20-pin connectors. Each connectors 
consists of: 

• six high-current drive lines 
• six indicator/status bits 
• one very high-current reset line 
• four relay ID bits 
• one relay power input 
• one 5 V input 
• one ground 

NOTE All devices connected to a particular bank (i.e. group of four connectors) must be of the same 
type: continuous or latching. Mixing of different type may result in erratic behavior and damage to 
overall system. 

OPEN-COLLECTOR VS. TTL DRIVE LINES 

The EX7300 and EX7400 relay drive connectors reside on RDBs that are partitioned into three 
banks: J2 through J5 constitute bank 0, J6 through J9 bank 1, and J10 through J13 bank 2. 
Although a single RDB may contain both latching and non-latching devices, the banks may only 
contain one type of device. For example, if J2, J3, and J4 are connected to non-latching devices, J5 
may only contain a non-latching relay. A latching relay could, however, be installed in J6. 

J13

J12

Some connectors have been removed for clarity. Bank 0Bank 1Bank 2

Relay Driver Board (RDB)
J9

J8

J7

J6

J5

J4

J11

J10

J3

J2

 

FIGURE 5-2: RELAY DRIVE CONNECTOR BANKS 
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Additionally, the RDB of the EX7300 and EX7400 may have varying quantities of open-collector 
and TTL drive lines, depending on the model ordered. This property is linked to the relay drive 
connector banks, as illustrated in Figure 5-2. The following table indicates how banks are used 
according the part number assigned. 

Part Number Bank 0 Bank 1 Bank 2 
-000 Open-collector Open-collector Open-collector 
-001 TTL Open-collector Open-collector 
-002 TTL TTL Open-collector 
-003 TTL TTL TTL 

 

 

CAUTION 
 It is imperative that TTL banks only have TTL devices connected to them. Connecting an 

open-collector device to a TTL port will result in damage to the RDB and, potentially, to 
other equipment in the test system. Failure to comply with this warning will result in voiding 
the manufacturer’s warranty. 

RELAY ACCESS & CONTROL 

Relay Power

Contact
(1 of 6)

Contact
(2 of 6)

Latch
5V

5V10k pullup
(optional)

4

to Comm Bus

to Comm Bus Indicator Contact 1
(relay dependent)

to Comm Bus ID Bits
(relay dependent)

Indicator Contact 2
(relay dependent)

Reset Line
Latching Relays

10k pullup
(optional)

RDB User Connections

 

FIGURE 5-3: RELAY DRIVER BLOCK DIAGRAM 

When asserted, the relay drive lines will sink the necessary current through the coils, effectively 
switching the relay. The user can program the relay settling time for each RDB. 

The relay control can be operated in two modes: Pulse and Continuous 

Continuous Mode 

Connecting non-latching devices to any bank of the RDB will dictate that bank must be operating 
in continuous mode. Commanded by software, the latch signal driving the FET will change state 
to activate/deactivate FETs and continuously stay in that state until the next command. All Relay 
Control Drive bits within a bank will change state at the same time. Continuous mode requires a 
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power supply capable of sustaining the high-current requirement. The user must allow an 
appropriate amount of time after the Relay Control Drive bit changes state for the relay to settle. 
This is typically between 10 ms to 30 ms. 

Drive x

Drive y

T (settle)

 

FIGURE 5-4: CONTINUOUS OPERATION MODE 

Pulse Mode 

Connecting latching devices to any bank of the RDB will dictate that bank must be operating in 
pulse mode. Commanded by software, the latch signal driving the FET will change state to 
activate FETs and then change state back when the settling time is reached. All Relay Control 
Drive bits within a bank will change state at the same time. Certain latching devices will require a 
reset signal to move all latches to a known state prior to a new state is applied. The Reset signal 
will be a pulse with the same duration as the Relay Control Drive. The pulse width should exceed 
the settling time specification for the relays being used. This value will be used as both pulse 
width and settling time. 

Reset Drive

Drive x

T (settle) T (settle) T (settle)
T (settle)

 

FIGURE 5-5: PULSE OPERATION MODE 

NOTE There is no current monitoring capability on the EX7000. It is the user’s responsibility to estimate 
the total current requirement and provide sufficient power supply current. 

The user can mix and match non-latching and latching devices among the banks. For instance, 
bank 1 and 3 can be all latching, bank 2 can be non-latching. The RDB, if set up properly, will be 
able to control all of the devices. 

In case of multiple RDBs, all devices in different boards can be controlled in parallel as long as 
the current requirement is met. The user does not have to wait for one RDB to finish its operation 
before moving to the next. On the contrary, the user can also control one RDB at time. The settling 
time in case of multiple RDB will be the longest between the boards, multiply with the aggregate 
number of banks connecting to latching devices. 
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 APPENDIX A 

EX7000 SYSTEM CONFIGURATOR 
INTRODUCTION 

All products in the EX7000 series share common programmatic characteristics. Each can be 
controlled using an IVISwitch class-compliant driver, the VTEXSwitch driver, which universally 
controls all VTI Instruments switch product family models. To achieve this architecture, each 
switch product carries its own device configuration file (DCF) which fully describes an 
instrument’s components and their interconnectivity. Once created, the DCF resides in the 
EX7000 system. The System Configurator can be used to manipulate a DCF from either a system 
or from a local drive. The user can modify and save multiple versions of a DCF, as needed, to 
configure multiple systems. Note, however, that, at any single point in time, an EX7000 system 
can contain only one DCF. 

STARTING THE CONFIGURATOR 

The System Configurator is located at <CD-ROM Drive>:\LXI Software\EX7000 Config Editor\ 
EX7000SystemConfigurator_Rnpn.jar on the Distribution CD provided with all EX7000 series 
products. Copy and save this applet to a local hard drive. After double clicking on the .jar file, the 
EX7000 System Configurator will open. 

NOTE In order to use the System Configurator, Java Runtime Environment (JRE) version 6.0 (or later) 
must be installed the host PC. 

 

FIGURE A-1: EX7000 SYSTEM CONFIGURATOR 

Once opened, the user can choose to either create a new DCF or can open and modify an existing 
DCF. This is done by selecting either Open or New in the File menu. 

http://www.java.com/en/download/windows_manual.jsp
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Opening an Existing Configuration 

To open an existing DCF, select Open from the File menu, then navigate to the location of the 
DCF to open. The System Configurator will then populate the System Explorer pane with various 
inherent items. If the DCF exists on an EX7000, enter the IP address of the device in the address 
bar, as shown in Figure A-2, then click on the Connect button. Once the configurator opens, select 
Get current configuration from the Target menu. This will import the DCF of the EX7000 into 
the System Configurator. 

 

FIGURE A-2: OPENING AN EXISTING DCF AT IP ADDRESS 10.1.3.55 

NOTE If a DCF references a component library, and the VTEXSwitch driver has not been installed on the 
host PC, the library must exist in the same directory as the EX7000SystemConfigurator_Rnpn.jar 
applet. 

Create a New Configuration 

To create a new DCF, select New from the File menu. A prompt will appear asking for the number 
of RDBs that the system will contain. Enter a number in this field between 1 to 8, inclusive. After 
entering a valid RDB count, the System Configurator will populate the System Explorer pane as 
shown in Figure A-3. 

 

FIGURE A-3: CREATING A NEW DFC FILE 

If the VTEXSwitch driver has been installed on the Host PC, the System Configurator will attempt 
to load the default component library. If a component library was not added to the configuration, 

System Explorer Pane 
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then it must be added manually by selecting Add Component Library under the Add menu. Use 
the browser to navigate to and select the “EX7000_library” file. 

 

FIGURE A-4: ADD MENU OPTIONS 

Saving a Configuration 

To save changes made to a DCF, select Save from the File menu. An explorer window will appear 
allowing the user to specify where the file will be saved. The DCF will be saved with a “.dcf” file 
extension. This should not be changed. It is convenient to save the DCF in the same directory as 
the component library (EX7000_library.dcf). 

Export a Configuration 

If a new DCF is created, it must be exported to the EX7000 system. This is done by entering the 
IP address of the target EX7000 into the configurator’s Address and then pressing the Connect 
button. Once connected, click on the Target menu and select Set as current configuration. 

 

FIGURE A-5: EXPORTING A DCF TO AN EX7000 

ADDING COMPONENTS 

When creating or modifying a DCF, the user has the ability to add or remove components from the 
system. Relays, wires, attenuators, parallel IO ports, and some passive devices are defined in the 
System Configurator and can be used when creating an EX7000 system. 

NOTE When using the System Configurator, only devices that appear in that component’s drop menu can 
be used. 
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Relays 

To add a relay to an EX7000 system, select Add Relay from the Add menu. The Add new relay 
prompt will appear. Select the relay type that will be used and provide a name for this component, 
then click the Add button to add this component to the EX7000 system. Continue to add relays in 
this manner until all relay have been defined, then close the prompt. Once the Add new relay 
prompt is closed, the added relays will appear in the Relays folder in the System Explorer. 

 

FIGURE A-6: ADDING AN AGILENT 87104A RELAY AS “SW1” 

When a relay is selected in the System Explorer, various properties can be viewed and edited. By 
default, the relay will be added to the lowest available drive line. This can be modified to fit the 
user’s setup by changing the value in the First drive line drop menu. In addition to changing the 
relay drive line, user’s can change the name of the relay, the reset drive line, and the wire 
connectivity as well. 

NOTE The EX72SF and the EX72CC are supplied from the factory prewired for the connections between 
the front panel switches and the RDB drive lines. Thus, SW1 must be configured to use drive line 
K1-1; SW2 must be configured to use drive K1-7, etc. Table 6-1 provides the required starting 
drive lines associated with each front panel switch position. 

Switch Drive 
SW1 K1-1 
SW2 K1-7 
SW3 K1-13 
SW4 K1-19 
SW5 K1-25 
SW6 K1-31 
SW7 K1-37 
SW8 K1-43 
SW9 K1-49 

SW10 K1-55 
SW11 K1-61 
SW12 K1-67 

 

 
TABLE 6-1: SWITCH CONFIGURATIONS AND RDB DRIVE LINES 
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FIGURE A-7: RELAY PROPERTIES WINDOW 

NOTE Latching and non-latching relays cannot be tied to the same RDB bank of relay drive lines 
(bank 0: Kn_1 to Kn_24, bank 1: Kn_25 to Kn_48, and bank 2: Kn_49 to Kn_72). For more 
information, please refer to the Open-Collector vs. TTL Drive Lines section in Section 5. 

Circuits can be created using the system components defined in the DCF by defining routing wires 
(see the Wire Types and Wires section for more information). Once a “wire” has been added to the 
configuration, it can be tied to existing relay pins via the wire drop menus shown in Figure A-7. 

Query 4-Bit Relay ID 

If configuring an EX71HD, it is possible to automatically discover the relays by using the Query 
4-Bit Relay ID command. In order to perform this query, enter the IP address of the EX71HD in 
the Address Bar and then click on the Connect button. Next, import the EX71HD_template.dcf 
file (see Opening an Existing Configuration). The default location of this file is C:\Program 
Files\IVI Foundation\IVI\Drivers\VTEXLibs. Once the DCF file has been installed, click on the 
Target menu and select Query 4-Bit Relay ID. The configurator will then use the miniature 
relay’s ID bits and populate the Relays directory. 

Note, this function only works for the EX71HD. 

Attenuators 

To add an attenuator to an EX7000 system, select Add Attenuator from the Add menu. The Add 
new attenuator prompt will appear. Select the type of attenuator that will be used and provide a 
name for this component, then click the Add button to add this component to the EX7000 system. 
Continue to add attenuators in this manner until all attenuators have been defined, then close the 
prompt. Once the Add new attenuator prompt is closed, the added attenuators will appear in the 
Attenuators folder in the System Explorer. For attenuators, the name and drive lines can be 
defined as well as the IN and OUT pins. 

Wire Drop Menus 

Dive Line Selector 

Reset Dive Line Selector 
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FIGURE A-8: ATTENUATOR PROPERTIES WINDOW 

Parallel I/O Ports 

To add a parallel IO port to the system, select Add Parallel IO Port under the Add menu. The 
parallel I/O properties window will appear as in Figure A-9. From here, the user can assign the 
port a reference designator (i.e. name) in the Port name text input box, the first drive line where 
the port begins by using the First drive line drop menu, and the number of the drive lines that the 
port contains by using the Number of drive lines text input box. 

 

FIGURE A-9: PARALLEL I/O PROPERTIES WINDOW 

Wire Types and Wires 

A wire is created to define a connection between two components in an EX7000 system. Before 
creating a wire, however, a wire type must be defined. The wire type is used to describe the 
physical characteristics (impedance, bandwidth) of a wire that will be used. 

To do this, select Add Wire Type from the Add menu. The Add new wire type prompt will 
appear. Enter a name for the wire type being created, then click the Add button to add this 
component to the system. Continue to add wire types in this manner until all wire types that will 
be used have been defined, then close the prompt. Once the Add new wire type prompt is closed, 
the added wire types will appear in the Wire Library folder in the System Explorer. When a wire 
type is selected in the Wire Library, the user can define the wire’s characteristic impedance (in 
ohms) and bandwidth (in GHz) as shown in Figure A-10. 
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FIGURE A-10: WIRE TYPE PROPERTIES WINDOW 

Once a wire type has been defined, a wire can added to the system. This is done by selecting Add 
Wire from the Add menu to bring up the Add new wire prompt. From here, select the wire type 
that will be used for the new wire and enter a name for the wire. Once this information has been 
provided, click on the Add button to add the wire to the system. When a wire is selected in the 
System Explorer, the user can define whether the wire is connected to a source, which will prevent 
its connection to other sources. 

 

FIGURE A-11: WIRE PROPERTIES WINDOW 

Passive Devices 

In addition to the active system components, various passive components can be added to an 
EX7000 system as well. For the purposes of this applet, a “passive device” is one that is not 
connected to a drive line and, therefore, cannot be controlled by software. To add a passive device, 
select Add Passive Device from the Add menu, select the desired passive device from the drop 
menu when the Add New Passive Device prompt appear, enter a name for the device, then press 
the Add button. The passive device will now be added to the System Explorer. When selected, a 
detail pane appears with detail appropriate for that device. Wires can be selected from the wire 
drop menus to establish the required connectivity. 

SYSTEM CONFIGURATION EXAMPLE 

As an example, a 2 x 2 RF matrix will be created as shown in Figure A-12 using one RDB, four 
7202-20 SPDT switch modules, an Agilent 84904 attenuator, and a user-defined parallel port. In 
Figure A-12, blue lines indicate wires in the system (such as W1), while red lines indicate drive 
line allocations (such as K1_1). To begin, open the System Configurator, then click on New in the 
File menu. When the RDB Count prompt appears, ensure that a “1” is entered in the text box 
(note, this is the default value). Click on the OK button to begin configuration. 
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FIGURE A-12: CONFIGURATION EXAMPLE 

When a new system is created, it contains “TTL1” in the Parallel I/O Groups folder and 
references the default component library. If desired, the user can click on System in the System 
Explorer pane and can use the fields provided to differentiate one system from another, although 
this is not required to configure a system. 

 

FIGURE A-13: SYSTEM PROPERTIES WINDOW 

To add the relays, select Add Relay from the Add menu. Here, we will select the “VTI 7202-20 
(SPDT)” from the drop menu. Per Figure A-12, “SW1” is entered as the relay name. Once this is 
completed, the Add button is clicked. These steps are repeated for SW2, SW3, and SW4. Once all 
relays have been added, the Add new relay prompt can be closed. 
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FIGURE A-14: ADDING A 7202-20 RELAY AS “SW1” 

Next, a wire type will be defined followed by the creation of wire connections to relays. To define 
a wire type, select Add wire type from the Add menu. In this example, the wire type will be 
called “Fifty_Ohm”. After entering the name, the Add button is clicked and the prompt is closed. 
When selected in the System Explorer, the impedance and bandwidth of the wire appears. In the 
example, the bandwidth has been changed to 20 GHz to match the bandwidth of the relay. 

 

FIGURE A-15: WIRE TYPE DETAIL PANE 

Once a wire type has been defined, define the wires in the system. This done by selecting Add 
wire from the Add menu. When the Add new wire prompt appears, the wire designators are 
entered into the Name text field, one at a time, and then the Add button is clicked to add the wire 
to the System Explorer. 

 

FIGURE A-16: ADDING A NEW WIRE AS “W1” 

With the wires defined, switch connectivity can now be set. To set the pin connections for relay 
SW1, select SW1 in the relay folder. Next, change the Pin (1) setting to “W1” to match the 
connectivity in Figure A-12 by using the wire drop menu. Then change Pin (2) to “W3” and 
Pin (C) to IN1 using the same method. Once all of the relays have been configured, their detail 
panes should appear as in Figure A-17. 
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FIGURE A-17: CONFIGURED RELAYS — SW1 THROUGH SW4 

Note that the First drive line for each switch already matches the example circuit. As the relays 
were added, the System Configurator determined the ports available and automatically added the 
relays to the available drive lines. If necessary, the relays can be tied to other drive lines by 
changing the value in the First drive line drop menu. 

At this point, the relays have been fully configured. They have been successfully connected to 
RDB drive lines as well as interconnected via wires. Next, the attenuator will be added to the 
system. To add an attenuator, select selecting Add Attenuator from the Add menu. In the 
example, an “Agilent 84904” is used. Select this component from the Add new attenuator 
prompt drop menu. Name the component “Attenuator_1” and click the Add button to add it to the 
system. 

The attenuator has now been added to the configuration. Again, the System Configurator 
successfully placed the component in the correct location by placing the attenuator at drive line 
K1_25. Complete the attenuator’s set up by setting the Pin (IN) and Pin (OUT) to the appropriate 
wire using the drop menus provided. 

 

FIGURE A-18: ATTENUATOR DETAIL PANE 
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The parallel port, the final component in the example system, can now be added. Add the port by 
selecting Add Parallel IO Port in the Add menu. Enter “ParallelPort_1” for the name, then enter 
“6” in the Number of drive lines text field. Note that, when selected, the System Configurator did 
not assign the component to the desired drive line (K1_37 rather than K1_42). Change this by 
selecting “K1_42” from the First drive line drop menu. 

 

FIGURE A-19: PARALLEL PORT DETAIL PANE 

This completes the example system. Save the configuration by selecting Save from the File menu 
to save, then save the file to a local computer. To export the configuration to the instrument, enter 
the EX7000’s IP address in the Address bar and click the Connect button. Once connected, select 
Set as current configuration from the Target menu. 

A text report of the configuration can be viewed by clicking on the Reports menu and selecting 
Configuration Summary. The report will appear below the detail pane of the selected 
component. The viewing area of the report can be modified by clicking on the separator bar and 
increasing or decreasing the size of the report pane. 

 

FIGURE A-20: CONFIGURATION SUMMARY REPORT 
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 APPENDIX B 

ONBOARD MEMORY 
MEMORY LISTINGS AND CLEARING PROCEDURES 

The following table provides information regarding memory contained in the EX7000. Protocol 
for clearing the memory is also included. 

Component Volatile? Contains User Writeable? Clear Procedure 

8MB Flash 
(Intel, TE28F640J3D-75) 

No Firmware No None 
Time Config Yes Go to webpage, change values 
Network Config Yes Go to webpage, change values 
DCF Yes Go to webpage, upgrade using Erase.DCP 

2x16 MB DRAM 
(Micron Tech, MT48LC8M16A2TG-7E) 

Yes Runtime Data Yes Power cycle machine 

1 Mb EEPROM (1 per RDB) 
(Xilinx, XCF01SVO20C) 

No FPGA No None 

8 KB Serial FRAM (1 per RDB) 
(Ramtron, FM25CL64-G) 

No Latching Config Yes Go to webpage, upgrade using Erase.DCP 

     
The ‘Erase.DCP’ Device Configuration Package file (P/N: 61-0042-000) can be loaded via the 
browser. 
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